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 Trademarks Unified Communication Server
Trademarks
Any brand names and product names included in this manual are trademarks, registered trademarks, or 
trade names of their respective holders.

To the Holder of the Manual
The contents of this manual are current as of the date of publication. ADTRAN reserves the right to change 
the contents without prior notice.

In no event will ADTRAN be liable for any special, incidental, or consequential damages or for 
commercial losses even if ADTRAN has been advised thereof as a result of issue of this publication. 

Software Licensing Agreement
Access to the features of the NetVanta Unified Communications software are restricted by license keys 
based on your licensed configuration. Pursuant to the Licensing Agreement, you may: (a) use the server 
software on one device only and (b) use the client software on an unlimited number of computers for use 
by configured users of the software product. In addition, certain ADTRAN systems may contain additional 
conditions for obtaining software upgrades. 

Toll Fraud Liability
Be advised that certain security risks are inherent in the use of any telecommunications or networking 
equipment, including but not limited to, toll fraud, Denial of Service (DoS) attacks, loss or theft of data, 
and the unauthorized or illegal use of said equipment. ADTRAN OFFERS NO WARRANTIES, EITHER 
EXPRESSED OR IMPLIED, REGARDING THE PREVENTION, DETECTION, OR DETERRENCE 
OF TOLL FRAUD, NETWORKING ATTACKS, OR UNAUTHORIZED, ILLEGAL, OR IMPROPER 
USE OF ADTRAN EQUIPMENT OR SOFTWARE. THEREFORE, ADTRAN IS NOT LIABLE FOR 
ANY LOSSES OR DAMAGES RESULTING FROM SUCH FRAUD, ATTACK, OR IMPROPER USE, 
INCLUDING, BUT NOT LIMITED TO, HUMAN AND DATA PRIVACY, INTELLECTUAL 
PROPERTY, MATERIAL ASSETS, FINANCIAL RESOURCES, LABOR AND LEGAL COSTS. 
Ultimately, the responsibility for securing your telecommunication and networking equipment rests with 
you, and you are encouraged to review documentation regarding available security measures, their 
configuration and implementation, and to test such features as is necessary for your network.

Service and Warranty
For information on the service and warranty of ADTRAN products, visit the Support section of the 
ADTRAN website at http://www.adtran.com

901 Explorer Boulevard
P.O. Box 140000

Huntsville, AL 35814-4000
Phone: (256) 963-8000

Copyright © 2014 ADTRAN, Inc.
All Rights Reserved.
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Conventions

Below is a list of naming conventions used in this document. The first example shows the naming 
convention used for the first occurrence; the second example shows the naming convention used for 
subsequent occurrences. 

Notes provide additional useful information.

Cautions signify information that could prevent service interruption or damage to 
equipment.

Warnings provide information that could prevent injury or endangerment to human 
life.

Type Convention Example

Operating System* Microsoft ® Windows Server ® 2008 operating system version R2 or later 
or Windows Server 2008 R2 or later 

Server Software NetVanta Unified Communications Server software or NetVanta UC Server software
NetVanta Unified Communications Live Attendant Server or Live Attendant Server

Client Software NetVanta Unified Communications Client software or NetVanta UC Client software
NetVanta ucCompanion Desktop Presence client software or ucCompanion
NetVanta ucCompanion Live Attendant or Live Attendant
NetVanta ucCompanion Soft Phone or Soft Phone

Hardware Server computer - the computer on which the server software is installed.
Client computer - the computer on which the client software is installed.

NetVanta Unified 
Communication Products

NetVanta Unified Communications Server or NetVanta UC Server
NetVanta Business Communications System or NetVanta BCS
NetVanta Enterprise Communications Server or NetVanta ECS
NetVanta Business Application Server or NetVanta BAS
NetVanta UC Live Attendant Server or Live Attendant Server

*   Other operating systems may be mentioned in this document. They will follow a format similar to the one provided.
619500001-29D Copyright © 2014 ADTRAN, Inc. 3
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1 Server Configuration Guide

Introduction

This guide is written for installers to configure the NetVanta Unified Communications Server at the 
customer site. It assumes that you have experience installing and programming PBXs and voicemail 
systems. It does not assume extensive knowledge of computer networks.

Before you run the NetVanta UC Server Configuration Wizard, make sure you follow all the instructions in 
the NetVanta Unified Communications Software Installation Guide available on ADTRAN’s Support 
Community at https://supportforums.adtran.com (article number 4394).

This guide covers the following main topics:

• Preparing to Start the Server Configuration Wizard on page 7 

• Starting the Server Configuration Wizard on page 13

Preparing to Start the Server Configuration Wizard

Before you start the NetVanta UC Server Configuration Wizard, you can further prepare your system by 
doing the following:

• Obtaining Network and Security Information on page 10

• Verifying Requirements and Recommendations on page 10

• Incorporating the Server into the Customer Domain on page 11

• Gathering Server Configuration Wizard Information on page 11

• Creating an Authorization Store to Enable Active Directory Roles on page 12

To set up DHCP options in Windows Server 2012

1. On the Start screen, open the Server Manager.

2. In Server Manager, select Tools > DHCP to open the DHCP management console.

3. In the left hand pane of the DHCP management console, select the server, and expand by selecting the 
right-arrow symbol.

4. In the expanded view, select IPv4, right-click on Server Options, and select Configure Options. The 
Server Options menu opens.

5. On the General tab scroll down the list to Option 66, and enable it using the check box. This enables 
the data entry for the option.

For additional ADTRAN documents, refer to the ADTRAN Support Community at https://
supportforums.adtran.com. 
619500001-29D Copyright © 2014 ADTRAN, Inc. 7

http://kb.adtran.com
https://supportforums.adtran.com/docs/DOC-4394
https://supportforums.adtran.com
https://supportforums.adtran.com
https://supportforums.adtran.com


 Preparing to Start the Server Configuration Wizard Unified Communication Server
6. Enter the IP address of the provisioning server in the String Value field. Polycom and ADTRAN 
branded Polycom phones retrieve configuration files from an FTP server with the user PlcmSpIp. This 
user is automatically created by the Phone Types wizard with the default password Pass$word1. 
When configuring the provisioning server for Polycom and ADTRAN branded Polycom phones, you 
must enter the address of the FTP server in the String Value field using the following format:

ftp://PlcmSpIp:<password>@<IPAddress>/

The <password> variable is the password of the PlcmSpIp user and the <IPAddress> variable is the 
IP address of the FTP server.

Polycom and ADTRAN branded Polycom phones retrieve configuration files from an FTP server with the 

user PlcmSpIp. This user is automatically created by the Phone Types wizard with the default password 

Pass$word1. When configuring the provisioning server for Polycom and ADTRAN branded Polycom 

phones, you must enter the address of the FTP server in the String Value field using the following format:

ftp://PlcmSpIp:<password>@<IPAddress>/

The <password> variable is the password of the PlcmSpIp user and the <IPAddress> variable is the IP 

address of the FTP server.Obtaining Network and Security Information

Obtain network and server information from the customer prior to configuration, such as service accounts 
and administrative passwords.

For security reasons, some customers might be reluctant to provide passwords and network information in 
this manner. If that is the case, the customer should make sure that this information is readily available 
when you arrive on site to do the configuration.

Verifying Requirements and Recommendations

You must install the NetVanta UC Server software on one of the supported Microsoft operating systems 
and use a server computer that meets the minimum requirements for the applications that are to be 
deployed. Refer to the appropriate NetVanta Unified Communications Release Notes available online at 
https://supportforums.adtran.com to determine the system requirements and compatible operating systems 
for the version of NetVanta UC Server software you are installing.

To ensure security, NetVanta UC Server accounts are given minimal permissions on the computer. The 
Server must be installed onto an NTFS partition on this server computer to make sure that proper security 
is in place.

The Exchange Server and NetVanta UC Server computer must be members of the same Windows domain.
 8 Copyright © 2014 ADTRAN, Inc. 619500001-29D
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Unified Communication Server  Preparing to Start the Server Configuration Wizard
Consult the NetVanta UC Server support website for additional up-to-date application or configuration 
notes.NetVanta UC ServerNetVanta UC Server

Incorporating the Server into the Customer Domain

Incorporating the NetVanta UC Server into the customer domain is required for Active Directory and 
Microsoft Exchange integration.

To incorporate the NetVanta UC Server

1. On the desktop, right-click My Computer.

2. Select Properties.

3. Select the Computer Name tab.

4. Select the Change... button.

5. In the Member of section, select Domain, and enter the domain name.

Gathering Server Configuration Wizard Information

The NetVanta UC Server Configuration Wizard provides a step-by-step guide for configuring your server. 
The Server Configuration Wizard is customized to configure the server according to the needs of your 
particular network configuration.

It is recommended that you have the information ready that you might need before you start the wizard. 
You need to know the following:

It is not recommended that you run NetVanta UC Server and the Exchange Server on the 
same system.

You require a domain administrator user name and password to complete this procedure.

Message store type Local only or
Local and Exchange or
Lotus Notes/IMAP

Computer names Includes Networking information and computer names

Server Account The dedicated account for running the Server

Microsoft Exchange names Microsoft Exchange Server computer name
Mailbox name for Service Account

NetVanta UC Server 
administrator password

The password that is used to configure the system. The default 
administrator login name is “admin.”
619500001-29D Copyright © 2014 ADTRAN, Inc. 9
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Creating an Authorization Store to Enable Active Directory Roles

The authorization store is typically created prior to running the Server Configuration Wizard.

The following conditions must be satisfied in order to create an authorization store:

• The NetVanta UC Server computer platform must be integrated with the customer’s network.

• The NetVanta UC Server Active Directory account must already be created on the customer’s domain.

• The user creating the authorization must be authenticated with the domain.

If users were already created prior to creating an authorization, the administrator must assign a role to each 
configured Windows User. Users added after the authorization store is created have a default role Standard 
User assigned to their user profile.

To create an authorization store

1. Log in to the NetVanta UC Server computer as a domain administrator.

2. Select Start > Run > CMD to launch a CMD window.

3. Navigate to the NetVanta UC Server installation directory:

\ADTRAN\NetVanta UC Server\bin

4. Type the following:

manageazman +createxmlstore +admin <DOMAIN>\<NetVanta UC Server 
SERVICE ACCOUNT>

PBX type Avaya Communication Manager or DEFINITY, Merlin Magix, Nortel 
Norstar, IP Office or generic analog

CTI link options
(Merlin Magix)

Used to configure advanced PBX integration for calling line ID

Port Name and Identity Used to configure all the ports that are connected to the PBX

User information Used to create and configure all the user accounts

Email configuration Used to configure the services when sending notification by email. If 
you do not have Exchange, you can configure an SMTP Server for email 
notification.

Creating an authorization store is an optional step that applies to NetVanta UC Server 
installations that are integrated with Active Directory. You can skip this step if you are 
configuring NetVanta UC Server as stand-alone.

If you have already followed the instructions in the NetVanta Unified Communication 
Server Planning and Deployment Guide for creating an authorization store, then you do 
not need to repeat the same steps below.
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5. Stop and restart the NetVanta UC Server application service by doing the following:

• Open the service control panel application.
• Restart the service named NetVanta UC Server Application Services.

Starting the Server Configuration Wizard

Login Requirements

Make sure that a computer account is created in the customer’s network. If you are integrating with 
Microsoft Exchange, make sure that you are logged on as a domain user that has:

• Domain administrator privileges—must be able to add users to the domain

• Exchange Server administrator privileges—must be able to create mailboxes and set permissions on the 
Exchange Server

Server Configuration Wizard Overview

The Server Configuration Wizard consists of several wizards that each become available after the 
successful completion of the previous wizard. The wizards are listed below:

1. Product Licensing Wizard on page 14 — enter your product and license key information

2. Windows Network Integration Wizard on page 14 — configure Windows Firewall, service account, 
and service connection point

3. Communication Systems Wizard on page 14 — configure your communications systems

4. Business Continuity on page 17 — configure the server’s Business Continuity role

5. Messaging Systems on page 22 — select message store type and configure accounts

6. Users on page 28 — add new or import existing users

7. Final System Configuration on page 36 — configure email notification system; create default user, 
operator and default mailbox; specify dialing rules and location; specify the system default voice

To start the Server Configuration Wizard

Select Windows Start > Programs > NetVanta UC Server > Server Configuration Wizard.
The main wizard screen guides you through the rest of the configuration.

You can create the custom authorization store at any time, before, during or after 
installation. However, any Active Directory users and their associated authentications will 
have to be modified to include a role from the role list. Consult the NetVanta Enterprise 
Communications Server Administrator Guide for details on how to change the 
authentication role for individual user authentications.
619500001-29D Copyright © 2014 ADTRAN, Inc. 11
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Product Licensing Wizard

Run this wizard to specify your product and license key information for NetVanta UC Server. You can 
paste the product and license key, and the machine ID, into the appropriate wizard boxes. The product key 
is provided with the product media. To obtain a license key, contact ADTRAN support at http://
adtran.com/support.  

Windows Network Integration Wizard

You can configure your Windows account to work with NetVanta UC Server. Create a service account: 
assign permissions to the directory, and assign the account to NetVanta UC Server.

Create a service connection point. A service connection point is an advertised name that can be used to 
locate NetVanta UC Server. When you start UC Client for the first time, the service connection point 
contains the name and IP address of the NetVanta UC Server. The user does not have to type a name, the 
name automatically appears in the list.

Communication Systems Wizard

You can define and configure new communication systems. Select a communication system type from the 
list provided. The communication systems listed have the required hardware and a valid license. You 
cannot create a communication system that is invalid. 

You can select an existing PBX, which you can connect to NetVanta UC Server through a Dialogic Media 
Gateway. For a list of PBXs supported by Dialogic, and for gateway configuration information, refer to the 
Dialogic website at www.dialogic.com. For more information on configuring the gateway to connect 
NetVanta UC Server to an existing PBX, refer to Configuring the Dialogic Media Gateway technical note, 
available on ADTRAN’s Support Community at https://supportforums.adtran.com (article number 2681).

The options that are available depend on the communications system type selected, but may include 
configuring message waiting, configuring the CTI link, selecting and configuring ports, and selecting a 
network adapter for the communication services.

The Port Configuration page allows you to choose a device ID, to enable and attach a name and an 
extension number to.

1. On the Start menu, select Administrative Tools, and then select Server Manager.

2. In the Server Manager Pane, in the Roles Summary section, select Web Server (IIS).

3. In the Web Server (IIS) section, select Add Role Services.

4. Under Role Services, select FTP Publishing Service. This will install the FTP service and the FTP 
management console.

5. Select Next, and then select Install.

The view of the NetVanta UC Server Configuration Wizard changes after entering a license 
key for NetVanta UC Server Standard Edition, as only those items applicable to the Standard 
edition are visible.
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To install the FTP service on Windows Server 2012

1. On the Start screen, select the Server Manager tile, then select Yes.

2. In the Server Manager Dashboard, select Add roles and features.

3. If the Before you begin page of Add Roles and Features Wizard is displayed, select Next.

4. On the Select installation type page, select Role-based or feature-based installation, and select 
Next.

5. On the Select destination server page, select Select a server from the server pool, select your 
server from the Server Pool list, and then select Next.

6. On the Select server roles page, expand the Web Server (IIS) node, and then expand the FTP 
Server node.

7. Select the FTP Server check box and the FTP Service check box, and then select Next.

8. On the Select features page, select Next.

9. On the Confirm installation selections page, select Install.

1. Select Start. 

2. In the Start search box, type services.msc, and press <ENTER>. Services will open.

3. In the Services menu, right-click on the Microsoft FTP Publishing Service service and select 
Properties. The Properties menu will appear.

Business Continuity

From the Business Continuity Wizard, you can configure the role of the NetVanta UC Server in the 
Business Continuity solution. 

You can configure the server role as either Standalone, Primary, or Secondary. The Standalone role is used 
when the NetVanta UC Server is not a part of a Business Continuity solution. The Primary role is used 
when the NetVanta UC Server is the Primary server in a Business Continuity solution. The Secondary role 
is used when the NetVanta UC Server is the Secondary server in a Business Continuity solution. 

How the server is licensed in the Business Continuity solution determines the server roles available in the 
Business Continuity Wizard. If the server being configured is licensed as a Primary server, you have the 
option to configure the server as a Primary server or Standalone server.  If the server being configured is 

The Business Continuity Wizard is only available if you have purchased a Business 
Continuity license key.
619500001-29D Copyright © 2014 ADTRAN, Inc. 13
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licensed as a Secondary server, you have the option to configure the server as a Secondary server or 
Standalone server.  

To configure the server as a Standalone server

1. Select the Standalone radio button. If the server is configured as a Standalone server, no Primary or 
Secondary server can be configured.  This role should be selected when Business Continuity is not 
being used.

2. Select Next, a summary page will appear.

3. On the summary page, review the Business Continuity role selection for the server.  Then, select 
Submit to accept the configurations.  

4. Once the wizard has configured the server’s Business Continuity role, select Next to exit the wizard.

For more information on installing a Business Continuity solution, please refer to the 
NetVanta UC Server Business Continuity Installation Guide available from ADTRAN's 
support community (https://supportforums.adtran.com).
 14 Copyright © 2014 ADTRAN, Inc. 619500001-29D
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To configure the server as a Primary Server

1. Select the Primary Server in a Business Continuity solution radio button, and enter the Secondary 
server's host name or IP address in the provided field. 

2. Select Next, a summary page will appear.

3. On the summary page, review the Business Continuity role selection for the server.  Then, select 
Submit to accept the configurations.  

4. Once the wizard has configured the server’s Business Continuity role, select Next to exit the wizard.
619500001-29D Copyright © 2014 ADTRAN, Inc. 15
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To configure the server as a Secondary Server

1. Select the Secondary Server in a Business Continuity solution radio button, and enter the Primary 
server's host name or IP address in the provided field.

2. Select Next, a summary page will appear.

3. On the summary page, review the Business Continuity role selection for the server.  Then, select 
Submit to accept the configurations.  

4. Once the wizard has configured the server’s Business Continuity role, select Next to exit the wizard.

Messaging Systems

Use the Messaging Systems Wizard to select a message store type, such as Microsoft Exchange Server, an 
Internet Message Access Protocol (IMAP) server, or a Simple Mail Transfer Protocol (SMTP) server, and 
to configure the message store account. For more information about configuring the desired message store 
account, refer to the following sections:

• Configuring Microsoft Exchange Server on page 22

• Configuring Microsoft Exchange Server EWS on page 26

• IMAP Server on page 27

• SMTP Server on page 27

Configuring Microsoft Exchange Server

When configuring Microsoft Exchange Server, there are several options available to consider. The 
following sections describe these options.

Selecting the Exchange Server version

NetVanta UC Server can connect to several versions of Microsoft Exchange Server. NetVanta UC Server 
version 5.1.0 automatically detects the version of the Exchange Server connected to the NetVanta UC 
 16 Copyright © 2014 ADTRAN, Inc. 619500001-29D
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Server and configures the connection settings accordingly. However, you can manually override the 
Exchange Server version selected by NetVanta UC Server using the Version drop-down menu of the 
Configure Exchange Server window. 

Connecting to Exchange Server 2010

The Client Access server (CAS) role was introduced in Exchange Server 2007 to accept client connections 
to services such as Outlook Web Access. Nevertheless, NetVanta UC Server (and other exchange clients) 
connect directly to the Mailbox server via Messaging Application Programming Interface (MAPI).

In Exchange Server 2010, the RPC Client Access service was introduced to allow the CAS to handle all 
MAPI connections. Instead of Exchange clients (including NetVanta UC Server) connecting to the 
Mailbox server directly, they must connect to the CAS via MAPI to access the Mailbox server. Because 
NetVanta UC Server integrates with Exchange Server using MAPI, this change can affect which physical 
server should be designated as the Server when configuring an Exchange Server 2010 connection in 
NetVanta UC Server. You must designate a physical server that hosts the CAS role as the Server. If, for 
example, the CAS role and Mailbox server role are hosted on separate physical servers, the server hosting 
the CAS role should be designated as the Exchange Server. If multiple physical servers host the CAS role 
in a CAS array, any one of these servers can be designated as the Server when configuring the connection. 

Connecting to Exchange Server 2013

In Exchange Server 2013, the CAS role solely provides authentication and proxy redirection for client 
connections. As of version 5.5.0, NetVanta UC Server uses Remote Procedure Call (RPC) over Hypertext 
Transfer Protocol (HTTP) to connect to the CAS in Exchange Server 2013. Consequently, when adding an 
Exchange Server 2013 to the NetVanta UC Server system, no Server is specified.

Configuring message delivery

When you configure Exchange Server, you can set the system-wide message delivery mode to determine 
whether voice and fax messages are sent from the system mailbox or are stored directly in users’ 
mailboxes. This setting affects whether:

• User defined message rules in Microsoft Outlook® or Microsoft Exchange Server are applied.

• Messages are sent to third-party applications such as BlackBerry® Enterprise Server.

• The caller's phone number appears in the From line of the message.

Each time NetVanta UC Server connects to Microsoft Exchange Server it will detect the 
Exchange Server’s version. If the version of Microsoft Exchange Server selected in 
NetVanta UC Server does not match the version detected, an error is logged. If the 
detected version of Microsoft Exchange Server is later than the current configuration, 
then the later version will be used for connectivity settings. For more information on how 
to access error logs, refer to Using Logs in the NetVanta UC Server available on 
ADTRAN’s Support Community at http://supportforums.adtran.com (article number 
2605).

NetVanta UC Server does not provide failover for Microsoft Exchange Server 
configurations with CAS arrays. If  the CAS server designated as the Server fails, 
NetVanta UC Server will not redirect to another CAS server in the array.
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The message delivery modes are as follows:

Synchronizing message waiting indicators for messages accessed through the Web or 
mobile devices

You can configure Exchange Server to monitor users’ mailboxes to determine when a new message arrives 
or is read, or when a message is marked as read or unread. The advantage is that when a user accesses their 
voicemail messages through Microsoft Outlook Web Access or a mobile device, the NetVanta UC Server 
adjusts the message waiting indicator on the user’s phone accordingly (to turn it on or off). Without 
mailbox monitoring, the NetVanta UC Server is unaware when a user accesses their voicemail messages 
through Outlook Web Access or a mobile device. For example, even after a user has accessed all their new 
messages, the message waiting indicator on their desk phone may continue to flash. 

However, mailbox monitoring can negatively impact system performance. Therefore, you may want to 
enable mailbox monitoring only for those users who require it.

The mailbox monitoring options are as follows:

Send messages 
from system mailbox

Voice and fax messages are sent from the system mailbox.  This mode has the 
following effects:

• Any user defined message rules set in Outlook or Exchange Server are 
applied. For example, a user's rule might direct messages from a particular 
contact to a specific folder.

• Messages are sent to any third-party applications such as BlackBerry 
Enterprise Server.

• The message appears to be from the system mailbox, and the From line 
does not include the caller's phone number.

Impersonate caller 
and store to mailbox

Voice and fax messages are stored directly in the user's mailbox, rather than 
being sent.  This mode has the following effects:

• User defined message rules in Outlook or Exchange Server are not applied. 
For example, a user's rule directing messages from a particular contact to 
a specific folder is not applied. 

• Messages are not sent to any third-party applications such as BlackBerry 
Enterprise Server.

• The From line includes the caller's phone number, or the caller's name from 
a contact that matches the phone number. 

Enable mailbox monitoring Opens the Exchange Server mailboxes of selected users at system start 
up. The NetVanta UC Server monitors each mailbox for changes such as 
a new message has arrived or is read, or a message is marked as read or 
unread. This applies only to the Inbox; other folders are not monitored. 
When a user accesses messages through Outlook Web Access or a 
mobile device, depending on the message waiting indicator (MWI) 
settings selected, the MWI turns on or off accordingly.
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Configuring a Microsoft Exchange Server Message Store

To configure a Microsoft Exchange Server message store, follow these steps:

1. Select Microsoft Exchange Server in the Select Messaging Servers window and select Next. The 
Configure a Microsoft Exchange Server window will appear. 

2. Use the Select the Exchange Server drop-down menu to select an Exchange Server that has been 
detected by NetVanta UC Server. If the server name does not appear in the list, a server name can be 
entered in the field. The server name is the name of the physical Exchange Server to which the 
NetVanta UC Server will be connected. If you are adding a Microsoft Exchange Server 2010 
(including service pack versions), you must select a server with the CAS role. Refer to Connecting to 
Exchange Server 2010 on page 22 for information on selecting the appropriate Microsoft Exchange 
Server 2010 server. 

3. If the version of the selected Exchange Server differs from the version in the Version field, use the 
drop-down menu to select the appropriate version of Microsoft Exchange Server. You may receive 
one of the following error messages when manually selecting the version of Microsoft Exchange 
Server:

Default setting for users If mailbox monitoring is enabled, then this mode turns mailbox 
monitoring for users on or off by default.

Mailbox monitoring works in conjunction with the MWI options set. For example, the 
MWI options determine if the message waiting indicator is turned off when the first 
message is read, or when all new messages have been read. 

Mailbox monitoring could negatively impact system performance. Mailbox monitoring 
increases the traffic between the Exchange Server and the NetVanta UC Server. On 
systems with more than 100 users, system design and engineering must consider the 
increased load of mailbox monitoring on the Exchange Server. Monitoring more than 500 
mailboxes requires careful consideration and should not be done without a slow roll-out 
procedure to validate the performance of both Exchange Server and NetVanta UC Server 
in the specific customer environment. If your Exchange Server is at or near maximum 
capacity, then you may want to disable mailbox monitoring.

If Microsoft Exchange Server 2013 is auto-detected or manually selected for the 
Version, the Select the Exchange Server option is disabled and cannot be changed 
without first manually selecting a different Exchange Server Version. 
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• Selected version differs from autodetected version
• The selected Exchange server has changed and no longer reflects the existing home mailbox 

configuration for the service account.

4. In the Mailbox field, enter the Microsoft Exchange Server mailbox name for the NetVanta UC Server 
service account. This mailbox is the Microsoft Exchange Server mailbox that has special access 
privileges in Exchange Server.  

5. In the Message delivery mechanism section, select one of the following options:

6. Select the Enable mailbox monitoring checkbox if you want to enable mailbox monitoring for 
specific or all users.

Configuring Microsoft Exchange Server EWS

You can configure NetVanta UC Server to connect to Microsoft Exchange Server using Exchange Web 
Server (EWS) to store and retrieve voice, fax, and email messages. 

Configuring a Microsoft Exchange Server EWS Message Store

To configure a Microsoft Exchange Server EWS message store, follow these steps:

If the service account has a mailbox defined for it in Active Directory, the associated 
mailbox name displays automatically and cannot be changed.

If Microsoft Exchange Server 2013 is auto-detected or manually selected for the 
Version, the Mailbox option is disabled and cannot be changed without first manually 
selecting a different Exchange Server Version.

Send messages from 
system mailbox

Voice and fax messages are sent from the system mailbox.

Impersonate caller and 
store to mailbox

Voice and fax messages are stored directly in the user's mailbox, 
rather than being sent.

Enable mailbox monitoring Opens the Exchange Server mailboxes of selected users at system 
start up. The NetVanta UC Server monitors each mailbox for 
changes in new message status, and depending on the MWI 
settings, adjusts the MWI accordingly.

Default setting for users If Enable mailbox monitoring is selected, you can use the On or 
Off radio buttons to turn mailbox monitoring for users on or off by 
default.

You can add only one Microsoft Exchange Server.
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1. Select Microsoft Exchange Server EWS in the Select Messaging Servers menu and select Next. 
The Configure a Microsoft Exchange Server EWS menu will appear. 

2. NetVanta UC Server will automatically detect the Microsoft Exchange Server URL. If necessary, the 
detected value can be overridden in the Configure a Microsoft Exchange Server EWS menu. To 
override the automatically detected Exchange Server URL, select the Override Exchange Server 
URL check box, and enter the Exchange Server URL in the provided field using the format https://
<server>/ews/exchange.asmx. The <server> variable is the fully qualified domain name (FQDN) of 
the physical Exchange Server that hosts the CAS role or the FQDN of any Exchange Server hosting 
the CAS role in a CAS array.

3.  NetVanta UC Server will automatically detect the Microsoft Exchange Server service account Simple 
Mail Transfer Protocol (SMTP) address. If necessary the detected value can be overridden in the 
Configure a Microsoft Exchange Server EWS menu. To override the automatically detected service 
account SMTP address, select the Override service account smtp address check box, and enter the 
Exchange Server mailbox name for the NetVanta UC Server service account. This mailbox is the 
Microsoft Exchange Server mailbox that has special access privileges in Exchange Server.

4. Use the Message delivery mechanism drop-down menu to select one of the following options:

5. Select Enable mailbox monitoring if you want to enable mailbox monitoring for specific or all users.

IMAP Server

Internet Message Access Protocol (IMAP) is a method of accessing and storing email messages. The 
NetVanta UC Server can integrate with IMAP version 4 revision 1 servers conforming to RFC 2060. For 
more information on IMAP version 4 revision 1, refer to www.ietf.org/rfc/rfc2060.txt. Add an IMAP server 
when you need to integrate NetVanta UC Server with Lotus Notes, Lotus Domino, Novell GroupWise, 
Google Mail (Gmail), or other servers. For more information on integrating NetVanta UC Server with 
Gmail, refer to the IMAP Integration with Google Mail technical note available on ADTRAN’s Support 
Community at https://supportforums.adtran.com (article number 2768).

If you change a mailbox name, the corresponding Exchange Server account might also 
need to be configured.

Send messages from 
system mailbox

Voice and fax messages are sent from the system mailbox.

Impersonate caller and 
store to mailbox

Voice and fax messages are stored directly in the user's mailbox, 
rather than being sent.

Enable mailbox monitoring Opens the Exchange Server mailboxes of selected users at system 
start up. The NetVanta UC Server monitors each mailbox for 
changes in new message status, and depending on the MWI 
settings, adjusts the MWI accordingly.

Default setting for users If Enable mailbox monitoring is selected, you can use the On or 
Off radio buttons to turn mailbox monitoring for users on or off by 
default.
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The NetVanta UC Server can use mailboxes on an IMAP server to store voice and fax messages in order to 
provide users with unified messaging functionality. In addition, users licensed for text-to-speech (TTS) can 
listen to their email messages from their mailbox over the telephone. 

To configure an IMAP server message store, follow these steps:

1. Select IMAP in the Select Messaging Servers window, and select Next. The Configure an IMAP 
Server window will appear. 

2. Enter the host name or IP address of the IMAP server in the Enter the network address for the 
IMAP server field. In some cases, such as Gmail, this can point to a proxy instead.

3. If you would like to select a service port for the IMAP server other than the default (port 143), select 
the Other radio button and enter a port number in the adjacent field. The port number is the IP port 
number of the IMAP service on the target server.

4. Select the Test button to verify that the host name or IP address that you specified is listening and 
displays the IMAP banner.

SMTP Server

The SMTP server is used to send emails, and is only required if you are not integrating with Microsoft 
Exchange. To configure an SMTP server, follow these steps:

1. Select SMTP in the Select Messaging Servers window, and select Next. The Configure an SMTP 
Server window will appear. 

2. Enter the host name or IP address of the SMTP server in the Enter the network address for the 
SMTP server field.

3. If you would like to select a service port for the SMTP server other than the default (port 25), select 
the Other radio button and enter a port number in the adjacent field. The port number is the IP port 
number of the SMTP service on the target server.

4. Select the Test button to verify that the host name or IP address that you specified is listening and 
displays the SMTP banner.

5. Enter the display name for outoging email in the provided field. This display name is sent with the 
email and appears on the recipient's email client.

6. Enter the outgoing email address in the provided field.  This address is the physical email address that 
is used to send email. The email account must exist with your service provider for SMTP to function 
correctly. An example of a sender email address is: myemailname@serviceprovider.com.

Depending on your server configuration, further configuration may be required from the 
NetVanta UC Server Administrator application to configure the appropriate message 
retrieval method. For more information refer to the NetVanta Unified Communications 
Server Administrator Guide available on ADTRAN’s Support Community at  https://
supportforums.adtran.com (article number 1252).
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7. Select Send a test email to send a test email using the defined display name and outgoing email 
address of the SMTP server. The Enter email address window will appear. In the provided field, 
enter a valid email address that you would like to receive the test email.  Then, select OK to send the 
test email.

Users

Use this wizard to add new users and import existing users from Active Directory, Microsoft Exchange 
Server, or from text files. The wizard allows you to select a location to import users from. You can also 
change user information before you create users. For more information refer to the following sections:

• Importing users from Active Directory on page 28

• Importing users from Exchange Server on page 29

• Importing users from text files on page 30

Importing users from Active Directory

You can select a group of users to import from Active Directory, and you can also automatically assign an 
extension number for each user. 

User naming convention

If you import users with a display name only, without specifying the first and last name, then users are 
imported as follows:

• If a display name is delimited with spaces, then the last 'word' is the last name, for example, "Bob Jeff 
Thompson"

lastname = Thompson

firstname = Bob Jeff

• If a display name is delimited with commas, then everything after the comma is the first name, for 
example, "Thompson, Bob J.”

lastname = Thompson

firstname = Bob J.

To import Active Directory users

1. From the drop-down list, select the Active Directory domain from which you want to import users.

2. Select Browse to search Containers on your system for the users that you want to import. 

3. If you specify a name prefix, the wizard imports users with names that begin with that prefix (this 
feature is not case sensitive). 

4. Enable the Create "Windows-enabled" Active Directory users check box if you want users to be 
able to use the single sign-on Active Directory feature.
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5. Enable the Use Active Directory for messaging configuration check box to link users' mailboxes to 
their corresponding Exchange mailboxes.

To change users’ specifications

• To return the wizard to the specification page, select Stop search and refine criteria.

To stop importing users

• To stop the import, select Stop search and process users. 

The configuration page appears with only those users that were imported up to that point.

Importing users from Exchange Server

To import users from Exchange Server

1. From the list, select the location of the Microsoft Exchange Server from which you want to import 
users. 

2. If you specify a name prefix, the wizard imports users with names that begin with that prefix (this 
feature is not case sensitive). 

With the list of users, you can assign the Identities (typically extensions). The wizard extracts the first 
name and last name from the Exchange Server. The users are associated with the Personal Assistant 
(PA) user profile, and have the system operator as the default dial "0" location. 

3. Select whether you want the users that you are importing to be linked to Active Directory.

To change users’ specifications

• To return the wizard to the specification page, select Stop search and refine criteria.

To stop importing users

• To stop the import, select Stop search and process users. 

The configuration page appears with only those users that were imported up to that point.

Importing users from text files

You can use Microsoft Excel to create a tab-separated text file to import Windows-enabled or local users. 
A Windows-enabled user is associated with an Active Directory user, while a local user is not. Local users 

If you are importing a large number of users, the process takes some time, and a progress 
page shows you how many users have been found so far.

If you are importing a large number of users, the process takes some time, and a progress 
page shows you how many users have been found so far.
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are configured to use local message store (LMS), while Windows-enabled users are configured to use 
Microsoft Exchange Server if one exists. Some fields are required and others are optional, depending on 
whether you're importing local or Active Directory users. 

For more information refer to the following sections:

• Structuring the Text File on page 30

• Using the Provided Excel File to Create the Text File on page 33

• Creating a Text File Using Microsoft Excel on page 35

Structuring the Text File

When using a text file to populate the NetVanta UC server, the wizard takes all the data from a specially 
formatted text file containing tab separated values. The following table describes the columns that can be 
included in the tab separated text file.

For more information on importing users from text files, refer to the Importing Users to 
NetVanta UC Server technical note available from ADTRAN’s Support Community at 
https://supportforums.adtran.com (article number 2766). A corresponding zip file also 
includes a Microsoft Excel file for importing users.

Table 1.  Text File Columns

Column Required Description Example
DisplayName Yes Name that appears in the 

Administration Users pane
John Smyth

GivenName Yes1 First name of the user John

Surname Yes1 Last name of the user Smyth

Extension Yes Identity that is associated 
with the user. It must be 
unique and cannot corre-
spond to an existing identity.

101
1234
56789

UserFax No Identity associated with DID 
fax. It must be unique and 
cannot correspond to an 
existing identity.

487
6543
31337

UserMode No Determines whether the 
Personal Assistant or the 
Personal Business Assistant 
is used for this user.
The default is PA.

PA – for Personal Assistant
PBA – for Personal Business 
Assistant

CommunicationSystem No Determines which communi-
cations system a user is 
associated with. If left blank 
or omitted completely, the 
communication system will 
be selected when the file is 
imported.

UC Server
Generic PBX (via SIP Gateway)
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MailboxID Yes2 Identifying string for the 
user’s Exchange Server, as 
defined in Active Directory

/o=First Organization/ou=First 
Administrative Group/cn=Recip-
ients/cn=jsmyth

WindowsUserEnabled Yes2 Determines whether to cre-
ate a Windows-User 
Enabled Account.

Yes
No

ADUserGuid Yes2 GUID of the object in Active 
Directory

6c4981f6413de3479b0845ae1a
f24203

ADUserSid Yes2 SID of the user in Active 
Directory, in S-1-5... format

S-1-5-21-2138396756-
507797660-930774684-1916

UserPrincipalName Yes2 The user e-mail address jsmyth@domain.com

TelephoneMacAddress No MAC address of the user's 
phone. The MAC address 
can be entered with or with-
out dashes or colons 
between octets.

00-04-F2-02-51-CA
12:34:56:78:90:AB
CDEF12345678

TelephoneType No The user’s phone type must 
appear exactly as it appears 
in the phone creation wiz-
ard.

Some possible values:
Aastra-480i
Aastra-480i cordless
Aastra-9112i
Aastra-9133i
Polycom SoundPoint IP-301
Polycom SoundPoint IP-320
Polycom SoundPoint IP-330
Polycom SoundPoint IP-4000
Polycom SoundPoint IP-430
Polycom SoundPoint IP-501
Polycom SoundPoint IP-550
Polycom SoundPoint IP-601
Polycom SoundPoint IP-650
snom-300
snom-320
snom-360
snom-370
Grandstream BT101
Grandstream BT102
Grandstream BT200
Grandstream GXP2000
Grandstream GXP2020
Grandstream GXV3000
Unknown

UmEnabled No Determines whether to work 
with Exchange UM
ExchangeUmDialPlan, 
UmPilotNumber and Proxy-
Addresses are required if it 
is TRUE

FALSE
TRUE

Table 1.  Text File Columns

Column Required Description Example
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1 Required for Dial by Name

2 Required for “Windows-enabled” users

3 Only required if UmEnabled is TRUE

Using the Provided Excel File to Create the Text File

The MailboxId, ADUserGuid, and ADUserSid fields required for “Windows-enabled” users are 
generally complex, so it’s not feasible to enter this data manually. One method to generate the tab 
separated values is to use the Excel file provided to build it for you, pulling the data from Active Directory, 
generating identity numbers, and so on.

1. Extract UserImportSheet.xlt from TN094 – Importing Users to UC Server.zip.

2. Open User Import Preparation Tool.xls with Microsoft Excel.

ExchangeUmDialPlan No3 This attribute specifies the 
UM dial plan that is associ-
ated with the UM mailbox 
policy.

UmPilotNumber No3 The UM Pilot Number

ProxyAddresses No3 This property specifies the 
extension for the user. A sin-
gle extension or a list sepa-
rated with exclamation 
marks (!) can be specified.

sip:jsmyth@domain.com!smtp:j
smyth@domain.com!SMTP:jsm
yth@domain.com!X400:c=US;a
=;p=Domain;o=HULL;s=Smyth;
g=James;

IncludeInDialByName No If set to no, user will be 
excluded from the dial by 
name feature. If set to yes, 
the user will be included. If 
left blank or omitted, 
assumed to be yes.

Yes
No

UserPin No Specifies the PIN used for 
accessing voicemail for the 
user. If omitted or left  blank, 
the PIN for the user will be 
the same as the extension. 
If the extension is less than 
four digits, it will be padded 
with prepended zeros to a 
length of four digits.

0101
1234
56789

UseADForMessaging No Is set to yes, the UC server 
will configure the users’ 
messaging according to 
what is set in Active Direc-
tory.

Yes
No

LoginName No If users are not using single 
sign on, they will log in using 
this login name.

Jsmyth
James Smyth

Table 1.  Text File Columns

Column Required Description Example
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3. If the Communications Server the users are being added to is not “UC Server” then enter it.

4. If Generated Extension is selected, set the Starting Extension Number.

5. Select Import from Active Directory.

6. Select the rows where accounts are not to become UC server users, right-click and select delete.

7. Confirm that the extensions are correct, re-numbering them if necessary, or enter them now if they 
were not created. Duplicate numbers will be highlighted red.

8. Add the TelephoneMacAddress and TelephoneType for all or some of the users. (Optional)

9. Select the Options worksheet.

10. Select Export Text Data.

11. Navigate to where the file should be saved, type a name for the file and select Save.

12. Close Excel.

13. Select No.

This will import every ‘user’ on your domain, including accounts that are not going to 
become UC server users, such as Administrator. It will not include disabled accounts.

Looking for entries missing GivenName, Surname, or MailboxId can provide a good 
idea of which ‘user’ accounts are not actually users. However, this will not catch all of 
them.

The default value for the UserMode column in the file is ‘PA’, so all imported users 
will be Personal Assistant users. If some or all users need to be Personal Business 
Assistant users, change ‘PA’ to ‘PBA’ to for each user that requires it.

The TelephoneType field values must be exactly the same as they appear in the Phone 
type drop-down menu in the new phone dialog. The TelephoneType field will be 
validated against the possible phone types. A drop-down menu is provided.

Phone MAC addresses can be read into the spreadsheet using a barcode scanner if the 
phones being used have MAC address barcodes. Depending on the scanner software 
being used, the MAC address is pasted to the current cursor location.
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Creating a Text File Using Microsoft Excel

This section only covers how to create local users because the MailboxId, ADUserGuid, ADUserSid, and 
UserPrincipalName fields required for “Windows-enabled” users are generally complex, so it is not 
feasible to enter this data manually and therefore it is omitted from this section.

1. Create a Microsoft Excel spreadsheet that has some or all of the following headings. At a minimum, 
the DisplayName and Extension must be specified.

• DisplayName
• GivenName
• Surname
• CommunicationSystem
• Extension
• UserFax
• TelephoneMacAddress
• TelephoneType
• UserMode

2. Enter the customer-provided user information into rows below the relevant headings, one row per user.

3. In Excel 2003 select File > Save As. In Excel 2007, select the Microsoft Office Button > Save As.

4. In the Save as type list, select Text (Tab delimited)(*.txt).

5. Type a name for the file.

6. Select Save.

7. Select OK, then Yes.

8. Close Excel.

9. Select No.

Importing Users From the Text File

1. Start the Server Configuration Wizard.

2. Select Users, Next, select “Import user Information from a text-based file” then select Next.

3. Select Browse, find the text file containing the users, select it, and select Open.

Phone MAC addresses can be read into the spreadsheet using a barcode scanner if the 
phones being used have MAC barcodes. Depending on the scanner software being 
used, the MAC address is pasted to the current cursor location.

If the text file contains the headers MailboxId, ADUserGuid, ADUserSid, and 
UserPrincipalName, the ‘Create Windows-enabled” Active Directory users’ and ‘Use 
Active directory for messaging configuration’ options will be automatically selected 
regardless of whether those fields are populated. 
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4. If your users need to use single sign-on and automatic synchronization with Active Directory, ensure 
the ‘Create “Windows-enabled” Active Directory users’ option is selected. This is a requirement to 
bind users’ mailboxes with their Microsoft Exchange mailboxes.

5. If you need to bind users’ mailboxes with their Microsoft Exchange mailboxes, ensure the ‘Use Active 
directory for messaging configuration’ option is selected.

6. If the server cannot access the instance of Active Directory the users are from, such as an off-site 
installation, ensure ‘Allow “disconnected” Active Directory user creation’ is selected.

7. Select Next.

8. Select the communication system that the entries that have no CommunicationSystem value should 
be associated with from the drop down menu and select Next.

9. If the entire text file is to be imported, select Select All to select every entry in the text file, and select 
Next. If only part of the file is to be imported, select the users to be imported and select Next.

10. Select Submit and wait for the task to complete.

11. Select Next, then Finish.

Final System Configuration

The Final System Configuration Wizard allows you to configure the administrator password, dialing 
properties, system operator, default mailbox, system default voice, and email notification system. To 
complete the Final System Configuration Wizard, follow these steps:

1. In the NetVanta UC Server Configuration Wizard menu, select Final System Configuration.  The 
Final System Configuration Wizard welcome menu will appear.

2. Select Next to begin the Final System Configuration Wizard. The Administrator Password menu 
will appear.

3. In the Administrator Password menu, you can configure the password used by the NetVanta UC 
Server administrator to log in to NetVanta UC Server to perform administrative tasks. Enter the 
desired administrator password in the Password field, and re-enter the password in the Confirm 
password field.  Once you have configured the password, select Next.  The Dialing Properties menu 
will appear.

4. Follow the directions provided in the Dialing Properties menu to specify the system location and  
dialing properties for outbound calls. Once you have configured the dialing properties, select Next.  
The Operator and Default Mailbox menu will appear.

If the options in steps 4 and 5 are selected but if any the values for these headers is not 
provided for some or all the users, those users will be created as local users instead of 
Windows-enabled users.

If you are creating local users, leave all options unchecked and proceed to step 7.
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5. Follow the directions provided in the Operator, Default Mailbox, and System Default Voice menu 
to configure the Operator identity, the Default mailbox, and the System Default Voice.  The 
Operator identity is the identity of the NetVanta UC Server operator to whom callers can transfer 
when accessing the voice mail service.  The Default mailbox is the mailbox to which NetVanta UC 
Server will deliver a voice or fax message if an error occurs while delivering the message. The 
System Default Voice is the default voice the system uses for prerecorded announcements, voice 
mailbox management, and voicemail behavior for the Voice Mail element and Personal Assistant 
mode. System voices combine a language, gender, and text to speech (TTS) generator. When you are 
finished, select Next.  The Notification email server menu will appear.

6. In the Notification email server menu, use the Send e-mail using drop-down menu to specify the 
messaging server that will send email notifications to email recipients when they recieve new voice 
and fax messages. Once you have chosen the notification email server, select Next. The final system 
configuration Summary menu will appear.

7. In the Summary menu, review the system settings. If you would like to change a setting, select Back 
to return to previous menus.  Otherwise, select Submit to submit the changes. NetVanta UC Server 
will automatically configure the changes.  

8. Once all tasks have been completed, select Next then select Finish.
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Appendix A.  Manually Configuring Accounts and Permissions

The information in this appendix is intended as reference material for the network administrator.

Before the installer arrives at your site, ensure that the required files for the configuration have already 
been installed on the UC Server computer. 

The following sections describe the manual procedures for some tasks that are typically performed 
automatically by the UC Server Configuration Wizard. These procedures may be required to be performed 
manually, since there may be some information about your network and hardware that the wizard cannot 
determine automatically. The procedures are described below in case some manual configuration is 
required.

• Configuring the UC Server User Account on page 39
• Configuring the Exchange Server Account and Permissions on page 40

Configuring the UC Server User Account

The Server Configuration Wizard typically creates a new user account on the computer network for UC 
Server. If this was not done automatically, then follow the steps below to create the account manually.

To manually create a user account for UC Server on the local machine (UC Server is not 
part of a domain)

1. Right-click My Computer on the desktop.

2. Select Manage.

3. Select Local Users and Groups.

4. Right-click Users.

5. Select New User.

6. In the New User dialog, enter the required user account information. 

The User name can be “UC Server” or a name that you choose.

7. Select Create.

To manually create a user account for UC Server in Active Directory (UC Server is part of a 
domain)

1. Select Start > Programs > Administrative Tools > Active Directory Users and Computers.

2. In the left pane, select Users > Action > New > User.

It is only necessary to follow the manual procedures below if the Server Configuration 
Wizard failed to do so automatically, or if you chose to do so manually in order to implement 
a custom configuration. 
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3. In the New User dialog box, enter the required user account information. 

The Logon Name can be “UC Server” or a name that you choose.

4. Select Next.

5. Enter the user password information, and select Next.

6. If you have Exchange on the computer, enable Create an Exchange Mailbox.

7. Select Next, and then select Finish.

Configuring the Exchange Server Account and Permissions

The UC Server user account provides a separate security context that does not require administrative 
permissions on the local computer or in the Domain Administrators Active Directory group. 

The UC Server account’s administrative privileges are limited to Microsoft Exchange Server mailboxes. 
The account must access Exchange user mailboxes in an administrative capacity because it uses them to 
store and retrieve messages.

Follow the relevant instructions below for configuring Exchange Server 2007, 2010, and 2013

• Integrating NetVanta UC Server with Exchange Server 2007 on page 40
• Integrating NetVanta UC Server with Exchange Server 2010, 2010 SP1 though SP3, or 2013 SP1 (or 

Later) on page 41

Integrating NetVanta UC Server with Exchange Server 2007

For NetVanta UC Server to function properly in a Microsoft Exchange Server 2007 environment, the 
NetVanta UC Server service account must be given the View-Only Administrator role and Send As, 
Receive As, and Administer Information Store permissions. To specify these settings, follow the steps 
below:

1. Access the Microsoft Exchange Management Shell by navigating to Start > Programs > Microsoft 
Exchange Server 2007 > Exchange Management Shell.

2. To set the administrator role to View-Only Administrator, enter the following command at the prompt:

add-exchangeadministrator <service account name> -role ViewOnlyAdmin

The <service account name> parameter is the name of the Windows account (for example, 
UCService).

3. To view the configured administrator role, enter the following command at the prompt:

get-exchangeadministrator | Format-List

Commands from this section cannot be pasted directly into Microsoft Exchange 
Management Shell. You must first paste the command into a text editor (e.g., Notepad) and 
replace all line breaks so that each command appears as one consecutive string. 
Otherwise, Microsoft Exchange Management Shell will recognize each line of command 
individually, and the commands will fail.
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4. Next, you will need to set the Send As, Receive As, and Administrator Information Store permissions 
for the account. Set these permissions by entering the following command at the prompt:

get-mailboxserver <exchange server name> | add-adpermission -user <service account name> -
accessrights GenericRead, GenericWrite -extendedrights Send-As, Receive-As, ms-Exch-
Store-Admin

The <exchange server name> parameter is the name of the Microsoft Exchange Server 2007 or the 
Microsoft Exchange cluster. The <service account name> parameter is the name of the Windows 
account. Neither the <exchange server name> nor the <service account name> can contain spaces 
when configuring Microsoft Exchange Server 2007 using Exchange Management Shell.

5. To view the configured account permissions, enter the following command at the prompt:

get-mailboxserver <exchange server name> | get-ADpermission -user <service account name> | 
Format-List

Neither the <exchange server name> nor the <service account name> can contain spaces when 
configuring Microsoft Exchange Server 2007 using Exchange Management Shell.

After setting the permissions, the Windows account should be displayed with a View-Only 
Administrator role and contain the Send As, Receive As, and Administrator Information Store 
permissions.

Integrating NetVanta UC Server with Exchange Server 2010, 2010 SP1 
though SP3, or 2013 SP1 (or Later)

This section provides instructions for integrating Microsoft Exchange Server with either MAPI/CDO or 
EWS. Both integration methods require that the service account be given specific permissions and the 
client throttling be disabled on the service account. Additionally, if Exchange is being upgraded from 
Exchange 2007 to Exchange 2010 or 2013, the NetVanta UC Server services must be stopped and the 
service account reset.

Configuring the Service Account Permissions

In order to integrate NetVanta UC Server with Microsoft Exchange Server 2010, the service account must 
be added to the View-Only Organization Management role group and given Send As, Receive As, and 
Administer Information Store permissions. To specify these settings, follow the steps below:

1. For Microsoft Exchange Server 2010, access the Microsoft Exchange Management Shell by navigating 
to Start > Programs > Microsoft Exchange Server 2010 > Exchange Management Shell. 

For Microsoft Exchange Server 2013, access the Microsoft Exchange Management Shell by navigating 
to Start > Programs > Microsoft Exchange Server 2013 > Exchange Management Shell. 

Commands from this section cannot be pasted directly into Microsoft Exchange 
Management Shell. You must first paste the command into a text editor (for example, 
Notepad) and remove all line breaks so that each command appears as one consecutive 
string. Otherwise, Microsoft Exchange Management Shell will recognize each line of 
command individually, and the commands will fail.
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2. To set the administrator role to View-Only Organization Management role group using the following 
command:

Add-RoleGroupMember "View-Only Organization Management" -Member "<service account 
name>"

The <service account name> parameter is the name of the Windows account (for example, UCServer). 
The <service account name> parameter can contain spaces when configuring Microsoft Exchange 
Server using Exchange Management Shell.

3. Next, you will need to set the Send As, Receive As, and Administer Information Store permissions at 
the common name level. Set these permissions by entering the following commands at the prompt:

Get-MailboxDatabase | Add-ADPermission -User "<service account name>" -AccessRights 
ExtendedRight -ExtendedRights Receive-As, ms-Exch-Store-Admin

Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights 
Send-As -User "<service account name>" -Identity "CN=Users,DC=<domain x>,DC=<domain 
y>,DC=<domain z>"

The <service account name> parameter is the name of the Windows account (for example, UCServer). 
The <service account name> parameter can contain spaces when configuring Microsoft Exchange 
Server using Exchange Management Shell.

The domain variables must be altered to match your implementation. The variables <domain x>, 
<domain y>, and <domain z> form the name of the domain. For example, if the domain name is 
example.organization.net, enter example for <domain x>, organization for <domain y>, and net for 
<domain z>. If you have problems with this command please check with your administrator to ensure 
you have the proper variables for your environment. 

The following is an example of these two commands using a UC Service account named UCServer for 
the domain division.department.company.com:

Get-MailboxDatabase | Add-ADPermission -User "UCServer" -AccessRights ExtendedRight -
ExtendedRights Receive-As, ms-Exch-Store-Admin

Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights 
Send-As -User "UCServer" -Identity "CN=Users,DC=division,DC=department,DC=company,
DC=com"

Disabling Client Throttling for the Service Account

NetVanta UC Server requires continuous access to multiple Exchange mailboxes in a typical installation. 
Microsoft Exchange Server 2010 and later implement a default throttling policy that limits the number of 
simultaneous connections to Exchange. It is recommended to increase the throttling value to allow 
NetVanta UC Server to make as many connections as possible to Exchange Server. To remove client 
throttling on the NetVanta UC Server service account, follow these steps:

In some installations, permissions cannot be set using the commands above due to 
external permissions issues between Active Directory and Microsoft Exchange. Refer 
to Setting Send-As Permission on Windows Server 2008 R2 on page 46 to set Send-As 
permissions for the NetVanta UC Server service account using Active Directory.
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1. For Microsoft Exchange Server 2010, access the Microsoft Exchange Management Shell by navigating 
to Start > Programs > Microsoft Exchange Server 2010 > Exchange Management Shell. 

For Microsoft Exchange Server 2013, access the Microsoft Exchange Management Shell by navigating 
to Start > Programs > Microsoft Exchange Server 2013 > Exchange Management Shell. 

2. For Microsoft Exchange Server 2010, enter the following command to create a new throttling policy 
called UCPolicy with all client throttling disabled:

New-ThrottlingPolicy UCPolicy -RCAMaxConcurrency $null -RCAPercentTimeInAD $null -
RCAPercentTimeInCAS $null -RCAPercentTimeInMailboxRPC $null -EWSMaxConcurrency $null -
EWSPercentTimeInAD $null -EWSPercentTimeInCAS $null -EWSPercentTimeInMailboxRPC $null 
-EWSMaxSubscriptions $null -EWSFastSearchTimeoutInSeconds $null -EWSFindCountLimit $null

For Microsoft Exchange Server 2010 SP1 through SP3, enter the following command to create a new 
throttling policy called UCPolicy with all client throttling disabled:

New-ThrottlingPolicy UCPolicy -RCAMaxConcurrency $null -RCAPercentTimeInAD $null -
RCAPercentTimeInCAS $null -RCAPercentTimeInMailboxRPC $null -EWSMaxConcurrency $null -
EWSPercentTimeInAD $null -EWSPercentTimeInCAS $null -EWSPercentTimeInMailboxRPC $null 
-EWSMaxSubscriptions $null -EWSFastSearchTimeoutInSeconds $null -EWSFindCountLimit $null -
CPAMaxConcurrency $null -CPAPercentTimeInCAS $null -CPAPercentTimeInMailboxRPC $null

For Microsoft Exchange Server 2013 SP1, enter the following command to create a new throttling policy 
called UCPolicy with all client throttling disabled:

New-ThrottlingPolicy UCPolicy -OwaMaxConcurrency Unlimited -EWSMaxConcurrency 
Unlimited -EWSMaxBurst Unlimited -EWSRechargeRate Unlimited -EWSCutoffBalance 
Unlimited -EWSMaxSubscriptions Unlimited -RcaMaxConcurrency Unlimited -RcaMaxBurst 
Unlimited -RcaRechargeRate Unlimited -RcaCutoffBalance Unlimited -CpaMaxConcurrency 
Unlimited -CpaMaxBurst Unlimited -CpaRechargeRate Unlimited -CpaCutoffBalance Unlimited

3. Enter the following command to apply the UCPolicy throttling policy to the NetVanta UC Server 
service account. The <service account> variable should be replaced with the name of the NetVanta UC 
Server service account.

Set-Mailbox -Identity <service account> -ThrottlingPolicy UCPolicy

In the following example, the service account is UC.Server@adtran.com:

Set-Mailbox -Identity UC.Server@adtran.com -ThrottlingPolicy UCPolicy
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4. If you are upgrading from Exchange Server 2007 to Exchange Server 2010, follow the steps in 
Upgrading from Exchange 2007 to Exchange 2010 or Exchange 2013 on page 44 to stop all NetVanta 
UC Server services and reset the NetVanta UC Server service account.

Modifying Session Limits for Exchange 2013 SP1

For Exchange Server 2013 integrations, additional registry modifications may be required for large user 
deployments and call volume scenarios. To exceed the session limits imposed by Exchange Server by 
default, the following steps are required using the registry editor: 

1. On the Exchange Server, open the Registry Editor (regedit.exe).

2. Navigate to the following location in the registry:

HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > MSExchangeIS > 
ParametersSystem

3. Create or edit the following dword values in the ParametersSystem registry key:

"DatabaseType"=dword:00000000
"Maximum Allowed Sessions Per User"=dword:000007d0
"Disable Session Limit"=dword:00000001
"Maximum Allowed Service Sessions Per User"=dword:000007d0

Upgrading from Exchange 2007 to Exchange 2010 or Exchange 2013

If you are upgrading from Exchange 2007 to Exchange 2010 or Exchange 2013, after configuring the 
permissions and throttling policy for the NetVanta UC Server service account, you must stop all NetVanta 
UC Server services and reset the service account. To do this, follow these steps:

1. Open Windows Explorer, and navigate to C:\Program Files (x86)\ADTRAN\NetVanta UC Server. 
Run the StopAllUCServerServices.bat file located in the folder. 

2. Next, navigate to Start > Administrative Tools > Services. The Services window will appear.

Ensure your registry is backed-up prior to making any modifications.

Please note that registry setting changes will only apply if the Exchange Server system is 
restarted or the Exchange Information Store service is manually restarted via 
services.msc.

If the name of the Exchange server changes during the upgrade process, additional steps 
may be required to change the name of the Exchange server in NetVanta UC Server. For 
more information, refer to Changing the Exchange Server Name within UC Server 
available from the ADTRAN Support Community (https://supportforums.adtran.com).
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3. Right-click ADTRAN NetVanta UC Server Application Services, and select Properties. The 
ADTRAN NetVanta UC Server Application Services Properties menu will appear.

4. In the ADTRAN NetVanta UC Server Application Services Properties menu, record the account that 
appears in the This account field. This is the service account used by the ADTRAN NetVanta UC 
Server Application Services service and will be reused in a later step. Select the Log On tab and select 
Local System account. Select Apply.  

5. Run the StopAllUCServerServices.bat file again. 

6. Access the Log On tab of the ADTRAN NetVanta UC Server Application Servies Properties menu 
using the procedure in Steps 2 and 3.
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7. On the Log On tab, select This Account and enter the appropriate account and password information 
for the NetVanta UC Server service account in the This Account, Password, and Confirm password 
fields. The service account used should be the account you recorded earlier in Step 4. Select Apply.

Setting Send-As Permission on Windows Server 2008 R2

The NetVanta UC Server service account must have the Send-As permission set on each Active Directory 
User object that is configured for NetVanta UC Server unified messaging. The Send-As permission can be 
granted to the containers holding these User objects, or to individual User objects. If you cannot set the 
permissions for the NetVanta UC Server service account using Exchange Management Shell, follow these 
steps to set the Send-As permission for service account using Active Directory.

1. Navigate to Start > All Programs > Microsoft Exchange >Active Directory Users and Computers. 
This will open Active Directory Users and Computers.

2. From the View menu, select the Advanced Features option.

3. Right-click on the appropriate domain, container, or user, and then select Properties. This is typically 
the Users folder in the root of a domain, but steps 3 through 8 can be repeated for multiple containers 
or OUs.

4. Navigate to the Security tab and select Advanced.

5. Select the service account that requires the Send As permission from the list. If the service account is 
not listed, select Add. Then select the service account name and select OK to add the account to the list. 

If the Security tab is not visible, make sure you selected Advanced Features in the View 
menu.
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6. When you have selected the proper account from the list, select User object in the Apply to list.

7. In the Permissions screen, select the Allow check box next to Send As.

8. Select Apply and then select OK.

9. Close the Properties window and then close Active Directory Users and Computers.

If you are using Windows Server 2008 R2 as the domain controller, select Descendant 
user objects in the Apply to list.
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